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Introduction

There are two email systems at Sussex, one for 
taught students and the other for staff and research 
postgraduates. This booklet is about the “staff” mail 
system. For more information about the email service 
for taught students, please see the help pages on the 
IT Services web site.

The staff mail system is built around Microsoft 
Exchange and email is delivered or sent from this 
central hub. Users can connect to Exchange using a 
variety of mail programs and use different devices, 
such as internet-enabled phones, laptops and other 
computers at home as well as desktop systems in the 
University.

The staff mail system may be accessed over the web 
using most web browsers (including Internet Explorer, 
Safari and Firefox) through an interface known 
as Outlook Web App and from Microsoft Outlook 
on Windows or Mac as well as from many other 
“IMAP” email programs (including Thunderbird and 
Mulberry).

We recommend that all users become familiar with 
using the Outlook Web App (OWA) since this offers 
both email and calendar management through a 5



common user interface which is available across all 
platforms. It’s particularly useful for home computers 
as you don’t need to install any software to handle 
your mail and electronic diary.

For Windows users, the booklet describes how to use 
Outlook 2007, which is available for staff PCs. Please 
note that Outlook Express is not the same as Outlook, 
although it can still connect in the same way as other 
mail programs like Thunderbird and Mulberry.

If you use a mobile phone or device to check your 
mail and calendar, you don’t have to synchronise 
using iTunes or Outlook. This booklet has details on 
setting up an iPhone (or iPod/iPad) or Android phone 
and information on connecting with other programs 
or phones is given on the website.

Please contact us if you have any questions about 
setting up or using the staff mail system - our contact 
details are on the back cover.

IT Services
University of Sussex
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Outlook Web App  
Logging in

Outlook Web App or OWA is a web-based version of 
Outlook which you can use to read your Sussex email 
from any computer with a web browser and internet 
access. Some web browsers work better than others 
- the most compatible are Internet Explorer 7 or 8 
and Firefox 3.6 or later but you can also use Chrome, 
Safari or Opera.

If you use a different web browser, you can still use 
OWA but you may see a simplified version, called 
OWA Light. This still gives you access to your email 
and calendar but doesn’t have all of the latest 
features.

Log on to OWA
•	go to exchange.sussex.ac.uk/owa/
•	enter your normal Sussex username (e.g. ano23) 

and password and click on Log On

You can tick the option for private computer at the 
top of the log on panel to stay logged in for longer 
(the public option will log you out after a few minutes 
if you have not been using it).

The first time you login, you will also be asked to 
confirm your preferred language and time zone – you 
can accept the pre-filled options and click OK.



Getting started

The standard settings in OWA mean that it looks a 
little bit different the first time you login. We suggest 
making a few minor adjustments to make life easier. 

Click on the down arrow next to View (just at the top 
of the list of messages) and

•	under Reading Pane choose Bottom
•	click Use Conversations to deselect it (the tick 

should disappear)

then in the folders list on the left of the screen

•	click on Favourites to hide the folders listed 
underneath it

These changes should make the OWA window look 
more familiar with a list of email folders on the left, 
and your emails on the right. When you click on an 
email, you should see a preview of it in the window at 
the bottom.

9
More online sussex.ac.uk/its/exchange

�� Viewing messages in conversations
�� Transferring contacts and address books



Reading and sending emails

Send an email
•	click on the New button above the list of messages 

and write your message in the window that pops up
•	click on the Send button to post the message

Look up addresses for Sussex staff
1  type a few characters of a person’s name in the To 

or Cc field
2  click the Check Names button
3  if a match is found, Outlook will fill 

in the rest of the address or let you 
choose from a list of similar names

click on a 
message 
to see a 
preview

double-click 
to open in a 
new window

10
More online sussex.ac.uk/its/exchange
In Outlook, emails and meeting requests all go to your Inbox

�� How to filter meeting requests into a different folder
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Deleting messages

Delete a message
1  click the message in the message list to highlight
2  press the Del key on your keyboard or click on the 

Delete button at the top of the message list

When you delete a message, it is stored in the 
Deleted Items folder. This means that if you delete 
a message by mistake, you can easily retrieve it, 
but deleted items still count towards your mail 
quota. Emptying the Deleted Items folder is a quick 
way to make space for new messages.

Empty the Deleted Items folder
•	right-click on the Deleted 

Items folder and choose Empty 
Deleted Items

Make sure you act on warnings 
about your quota as you will be 
unable to send or receive until 
you reduce your email.

More online sussex.ac.uk/its/exchange
�� How to recover emails emptied from Deleted 

Items within the last 28 days



Attachments

On incoming emails, attachments are listed just 
above the main body of the message. 

•	click on the name of the file to open it 
•	right-click and Save Target As to save it
•	right-click and Print the file without opening it.

Send an attachment
1  Click on the Attach button 
2  Choose the file you 

want and click Open 
(click Browse if you 
don’t see a list of files)

3  A list of the files you 
have chosen will then appear in a new window 
beneath the Subject

4  If you change your mind and want to delete an 
attachment, click on the small      next to its name

Some of the processes in OWA may differ slightly 
depending on the web browser you are using.

12
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Opening the calendar

Click on the calendar button
in the bottom left corner
to open your calendar

You can then change the layout of 
the page to show a daily, weekly or 
monthly view.

Working week
The Working week view is often useful and you can 
change the days of the working week to match your 
working patterns:

1  choose Options, then See all options
2  click on Settings and choose Calendar
3  set your working days and hours in the Appearance 

section
4  click on Save 

Click on My Mail 
(top right) to close 
the settings page



Appointments and events

As with the desktop version of Outlook, there are four 
types of activity that you can add to your calendar: 
appointments, events, meetings and tasks (see p26).

Add an appointment
1  double-click on the intended day and time in your 

calendar
2  enter a name for the appointment and a location if 

appropriate
3  click on Save and Close

Change the details
•	click on the square handles to change the duration
•	click and drag to move to a different time
•	double-click to edit the name and location details
•	right-click to delete or mark the time as free/busy

Convert to an event
In Outlook, an event is an activity which does not 
occur at a particular time and is therefore referred to 
as an all day event:
•	double-click on an appointment to edit
•	tick the all day event box
•	click on Save and Close

14
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Reminders
When you set up a new appointment or event, a 
reminder is automatically set to alert you before it 
starts. To change the reminder time:

•	double-click to open an activity and choose a time 
from the drop-down list next to the word Reminder

Change status to free or busy
1  right-click on the activity and choose Show time as
2  choose the appropriate option

New appointments and meetings are automatically 
set to busy and events to free.

Categorise with colours
1  double-click on an activity
2  click the Categories icon and 

select a colour

You can also click on Manage 
Categories to set up your own 
colours and definitions.

Create a recurring calendar item
1  double-click an event or appointment
2  click on the recurrence icon



Meetings

In Outlook, a meeting is an appointment with 
attendees. 

Set up a meeting
1  double-click on the intended day and time
2  enter the basic details for the meeting
3  click on the Invite attendees icon and 

then type their names in the To box
4  alternatively click on Scheduling 

Assistant to check the availability of colleagues at 
Sussex

Share your calendar
1  click on Share and choose Share This Calendar
2  put the names of the people with whom you want 

to share in the To field and click on Send
3  change permissions at any time by choosing Share 

and then Change Sharing Permissions

View the calendar of a colleague
1  click on Share and choose Add Calendar
2  click Name to see a list of calendars you can add
3  click a name to choose it and then click OK

16
More online sussex.ac.uk/its/exchange

�� Advanced options for sharing your calendar with 
colleagues and assistants
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Additional calendars

Outlook enables you to have more than one calendar 
and switch between seeing each one separately or a 
combined view of all your calendars.

Create an additional calendar
1  right-click My Calendars in the left-hand panel and 

choose Create New Calendar
2  enter a name for the new calendar and press enter

Show or hide calendars
1  in the left-hand panel, tick the boxes for the 

calendars you want to see or un-tick to hide
2  calendars are shown side-by-side

More online sussex.ac.uk/its/exchange
�� Organising calendars into groups
�� Customising your calendar
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Microsoft Outlook for PC
Getting started

Your login details for Outlook are “ad_us\” followed 
by your normal Sussex username (e.g. ad_us\ano23) 
and your normal password. Please see the Quick 
Start leaflet or refer to our website for details of how 
to set up Outlook the first time you use it.

If your Outlook window doesn’t look like the picture 
the first time you login, we suggest starting with a few 
minor adjustments to make it look more familiar.

From the View menu:

•	choose Reading Pane and then Bottom
•	select Navigation Pane and check there is no tick 

next to Favorite Folders (if there is, click on it to 
deselect it)

•	choose To-Do Bar and then Off
•	choose Arrange By and then make sure there is no 

tick next to Show in Groups (and if there is, click to 
deselect)

These optional adjustments should make the Outlook 
window look like the picture on the facing page with a 
list of folders on the left, and your emails on the right. 



When you click on a 
folder, the emails are 
displayed in this list

Your email folders 
are displayed in 
this panel

Click on an email in the list to 
see a preview of the message 
in this panel

Use these buttons 
to switch between 
email and calendar

19

Auto-archiving
You may find that Outlook is set to auto-archive 
information to your local computer. We suggest 
turning this off to start with: go to Tools, Options, 
Other and under Auto-Archive, untick the box to 
Auto-Archive every 14 days.
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Reading and sending emails

Read your email
•	click on an email to see a preview
•	double-click to open it in a new window

More online sussex.ac.uk/its/exchange
�� Viewing messages in threads or groups

To sort the message list, click 
on the appropriate header. Click 
again to reverse the order.
Send a message
1  click on New
2  your message will open 

in a window similar to 
Microsoft Word

3  enter the recipients’ email 
addresses in the To and Cc 
fields

4  give your mail a Subject
5  type the message
6  click on Send
Set up a signature
1  go to Tools then Options and choose Mail Format
2  click on the Signatures button and then New
3  enter a name for the signature, type it into the box 

below and click OK to finish



Find an address
Type the first few characters of the recipient in the To 
or Cc field
•	if you have emailed someone from Outlook before, 

press enter to auto-fill the address or see a list of 
possible matches

•	for staff at Sussex, click on Check Names
•	when typing a new message, click on the To button 

to look up a Sussex colleague

Check spelling and grammar
•	press F7 to turn on spell-checking
•	click the down arrow on the 

Spelling button for more options
•	right-click on a word and look it up 

in the dictionary

Extras on the Options tab
•	flag your message as important
•	request an (optional) read receipt from recipients

Respond to a message
•	Reply just to the sender or Reply to all recipients 

(all the addresses listed in the To or Cc fields)
•	Forward a message to a new recipient

More online sussex.ac.uk/its/exchange
�� Using contact lists
�� Transfer your existing address books to Outlook 21



Managing your mail

In Outlook your entire mail store - Inbox and other 
folders - is known as your Mailbox. A subdivision of 
this is known as a Folder.

Create a new folder
•	click on the down arrow to the 

right of the New icon and select 
Folder... 

•	specify the type of folder you 
require (Mail and Post Items) 
and choose the location

Move a message into a folder
•	drag it from the message list onto the appropriate 

folder icon

All of the emails in your folders count towards your 
personal mail quota. To make space for new emails, 
make a regular habit of deleting messages you no 
longer need.
Make sure you act on warnings about your quota 
as you will be unable to send or receive until you 
reduce your email.

More online sussex.ac.uk/its/exchange
�� Viewing email for group accounts
�� Delegating permissions to a colleague or assistant22
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Deleting messages

Delete an email
•	click on the message to highlight it and then click 

the      in the tool bar or choose Edit and then 
Delete

•	if you are viewing a message in a new window, click 
on the Delete button

Empty the Deleted Items folder
In Outlook, a message is moved to the Deleted Items 
folder and will stay there (and still count towards your 
mail quota) until you empty the folder.

To empty the folder:

•	choose Tools from the 
main menu and then 
Empty Deleted Items 
folder

More online sussex.ac.uk/its/exchange
�� How to recover emails emptied from Deleted Items 

within the last 28 days
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Attachments

Attachments on incoming messages are listed just 
above the main message.

•	drag into a folder on your computer to save it
•	double-click to open it

Remember the Save As Rule - when you double-click 
to open, save it to your My Documents folder using 
Save As before you make any changes. Otherwise, it 
is saved in a temporary location and changes may be 
lost.

Send an attachment
1  click on the Insert tab in 

the Message window and 
then the paperclip icon

2  browse for the file to be inserted

The message will appear as an 
icon in a new Attached field in the 
message headers.
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Opening the calendar

The calendar can be read in Day, Work Week, Week 
or Month view. Use the buttons on the standard 
toolbar to switch between the different calendar 
views.

Customise the days of your working week
1  from the Tools menu, click Options
2  on the Preferences tab, click Calendar Options 
3  in the Calendar work week section, select or clear 

the check boxes for the days that you want to be 
displayed

Click on the Calendar 
button 

More online sussex.ac.uk/its/exchange
�� Using the To-Do bar for quickly navigating the calendar



Activities

You can schedule different types of activity in your 
Outlook calendar:

•	An appointment is an activity that involves only 
you, at a scheduled time.

•	A meeting occurs at a scheduled time, like an 
appointment. The difference is that you invite other 
people by using a meeting request that is sent via 
e-mail.

•	An event is an activity that does not have a 
scheduled time. By default it doesn’t block out time 
in your calendar. You can still have other entries 
appear in your calendar for that day.

•	A task is an activity that involves only you, and that 
doesn’t need a scheduled time. 

event
appointment

meeting

tasks

26
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Appointments and events

Create an appointment
1  rest the pointer over the time in your calendar and 

click when Click to add appointment appears
2  enter the details
3  click and drag the square handle to 

increase the time span
4  to make the appointment an event, 

double-click and tick the box for All 
Day Event

Change the details
1  double-click to open
2  edit details as required
3  click on Save & Close

Delete an appointment or event
1  click once to select
2  click     on the toolbar or press the Delete key

Other actions
•	To move an activity, click and drag to the new time 

in your daily view
•	To copy it, hold down the Ctrl key then click and 

drag to the new time

Change the duration
1  select the appointment 

or event
2  click and drag the 

square handle to 
increase or decrease 
the time span



Reminders
•	for all new activities, a reminder is set for 15 

minutes before the start 
•	to change it, double-click on the appointment or 

event and choose a reminder time

Change status to free or busy
1  right-click on the appointment or event and click 

Show Time as
2  choose the appropriate flag

New appointments are automatically set to busy 
and events to free.

Categorise with colours
1  right-click on an appointment
2  choose Categorise and then select a colour

Create a recurring appointment
1  click on an appointment to select it
2  from the Appointment tab, Options Group, click 

the Recurrence icon

To amend a recurring 
appointment, double-click on 
it and then choose to amend 
the entire series or just this 
event.

28
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Meetings

Set up a meeting
1  Make an appointment entering subject, location, 

start time, end-time and reminder
2  open the appointment then click Invite Attendees
3  use the Rooms... button if there’s a 

calendar for the location 
4  click on To... and select the attendees
5  click Send to mail the details to attendees

Viewing a colleague’s calendar
If a colleague lets you see their calendar, 
it will appear on the left under People’s 
Calendars. Check the box next to a 
calendar to display it.

Share your calendar
1  select Share My Calendar... from the 

left-hand menu
2  choose the names by clicking on To...  
3  click on Send



Additional calendars

Outlook enables you to have more 
than one calendar and switch between 
seeing each one separately or looking 
at a combined view of all of your 
calendars.

Create an additional calendar
1  click the arrow next to New at the top 

of the window and choose Calendar
2  enter a name for the calendar in the Create New 

Folder dialog box

Show or hide calendars
•	tick the boxes for the calendars you want to see or 

un-tick to hide

Overlay calendars
•	click the View in Overlay Mode 

arrow on the calendar tab
•	click the View in Side-By-Side 

Mode arrow to restore side-by-
side mode

More online sussex.ac.uk/its/exchange
�� Customising your calendar
�� Giving access to delegates and assistants30
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Adding your Sussex Direct calendar

If you have a teaching timetable in Sussex Direct, you 
can view it alongside your other calendars. Changes 
to the Sussex Direct timetable will automatically be 
reflected in Outlook.

Add a teaching timetable
1  in Sussex Direct, go to Teaching, then Timetable 

and then Teaching Timetable
2  scroll to the foot of the screen and click on 

Subscribing to your Sussex Direct timetable from 
an external calendar

3  highlight the link for your calendar and copy it
4  in Outlook, choose Tools then Account Settings
5  select the Internet Calendars tab and click New
6  paste your calendar link into the box and click Add
7  give your calendar a name (e.g. Teaching 

Timetable) and click on OK

After a few seconds 
your Sussex Direct 
timetable will 
appear under Other 
Calendars on the 
left. Tick the box to 
display it.



Outlook for Mac
Getting started, reading and sending emails

When you use Outlook for the first time, we suggest 
starting with a few minor adjustments to make the 
interface more familiar.

From the View menu:
•	select Reading Pane and then Below
•	ensure Navigation Pane is ticked
•	select Arrange By and ensure Show in Groups is 

not ticked

Read your email
•	click on an email to see a preview
•	double-click to open it in a new window

To sort the message list, click on a 
header. Click again to reverse the 
order.

More online sussex.ac.uk/its/exchange
�� Viewing messages in threads or groups
�� Setting up a signature for outgoing messages32
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Send a message
1  click on New and choose 

E-mail Message
2  a blank message will open in a 

new window
3  enter the recipients’ email 

addresses in the To and Cc fields
4  give your mail a Subject, type the 

message and click Send 

Find an address
Type the first few characters in the To or Cc field
•	if you have emailed someone from Outlook before, 

a list of possible names will appear while you type
•	for staff at Sussex, click on the Check Names 

button at the top right of the window

Check spelling and grammar
•	click on Options and then Spelling to check the 

spelling in your message
•	hold down Ctrl and click on a word to look it up

Respond to a message
•	Reply just to the sender or Reply All to include all 

recipients in your reply (all the addresses listed in 
the To or Cc fields)

•	Forward a message to a new recipient

More online sussex.ac.uk/its/exchange
�� Using contact lists
�� Transfer your existing address books to Outlook



Managing your mail

In Outlook your entire mail store - Inbox and other 
folders - is known as your Mailbox. A subdivision of 
this is known as a Folder.

Create a new folder
•	click on the place where the new 

folder should be located (e.g. Inbox)
•	click on the the New icon and select 

Folder
•	type a name for your folder and 

press enter

Move a message into a folder
•	drag it from the message list onto the appropriate 

folder icon

All of the emails in your folders count towards your 
personal mail quota. To make space for new emails, 
make a regular habit of deleting messages you no 
longer need.

Make sure you act on warnings about your quota 
as you will be unable to send or receive until you 
reduce your email.

34
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Deleting messages

Delete an email
•	click on the message to 

highlight it and then click the 
Delete button in the tool bar

•	if you are viewing a message in 
a new window, click on the Delete button

Empty the Deleted Items folder
In Outlook, a message is moved to the Deleted Items 
folder and will stay there (and still count towards your 
mail quota) until you empty the folder.

To empty the folder:

•	click on the deleted items 
folder, and Ctrl+click,  then 
choose Empty Folder

More online sussex.ac.uk/its/exchange
�� How to recover emails emptied from Deleted Items 

within the last 28 days



Attachments

Attachments on incoming messages are listed just 
above the main message.

•	drag into a folder on your computer to save it
•	double-click to open it
•	click the Preview button for a quick peek inside

Remember the Save As Rule - when you double-click 
to open, save it to your My Documents folder using 
Save As before you make any changes. Otherwise, it 
is saved in a temporary location and changes may be 
lost.

Send an attachment
1  click on the Attach button in the 

Message window when you are 
writing a new message

2  browse for the file to be inserted

The message will appear as an icon in a new 
Attached field in the message headers.

36
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Opening the calendar

The calendar can be read in Day, Work, Week or 
Month view. Use the buttons on the standard toolbar 
to switch between the different calendar views.

Customise the days of your working week
1  from Outlook in the menubar, click Preferences
2  click Calendar 
3  select the days of your working week (shown in a 

darker shade) and your start and end times

Click on the Calendar 
button 



Activities

You can schedule different types of activity in your 
Outlook calendar:

•	An appointment is an activity that involves only 
you, at a scheduled time.

•	A meeting occurs at a scheduled time, like an 
appointment. The difference is that you invite other 
people by using a meeting request that is sent via 
e-mail.

•	An event is an activity that does not have a 
scheduled time. By default it doesn’t block out time 
in your calendar. You can still have other entries 
appear in your calendar for that day.

•	A task is an activity that involves only you, and that 
doesn’t need a scheduled time. 

event

appointment

meeting

38
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Appointments and events

Create an appointment or event
1  double-click on the calendar window at the time of 

the appointment
2  enter the details for the appointment in the window 

that appears
3  to make the appointment an event, tick the box for 

All Day Event

Change the details
1  double-click to open
2  edit details as required
3  click on Save & Close

Change the duration
1  click the activity to highlight it, then move 

the cursor over the bottom or top edge of the 
appointment and wait for it to change shape

2  click and drag to change the druation

Delete an appointment or event
1  click once to select
2  click on the Delete button on the toolbar or press 

the Delete key



Reminders
•	for all new activities, a reminder is set for 15 

minutes before the start 
•	to change it, double-click on the appointment or 

event and choose a reminder time from the drop-
down list in the toolbar

Change status to free or busy
Double-click on the appointment or event and change 
status to Free, Busy, Tentative or Out of Office.

New appointments are automatically set to busy and 
events to free.

Categorise with colours
1  right-click on an appointment
2  choose Categorise and then select a colour

Create a recurring appointment
1  double-click on an appointment
2  click the Recurrence button and choose the 

appropriate interval

To amend a recurring appointment, double-click on it 
and then edit the details (to change a single event) or 
click Edit Series to change all recurring events.

40
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Meetings and calendars

Set up a meeting
1  Make an appointment entering subject, location, 

start time, end-time and reminder
2  open the appointment then click Invite
3  enter attendees in the To field as for an email 

message
4  click Send to invite the attendees

Sharing calendars
In the Organize tab, click on Open Calendar to 
view a calendar shared with you by a colleague. To 
share your own calendar with someone else, click 
Permissions.

Set up additional calendars
Outlook enables you to have more than one calendar 
and switch between seeing each one separately or 
looking at a combined view of all of your calendars.

•	in the Organize tab, click on New Calendar
•	type a name for calendar
•	tick the box to display it



Apple Mail, iCal and iPhone
Setting up

Staff with Macs can use the native mail and 
calendaring applications to manage their staff email 
and calendars. Snow Leopard or later is needed - 
please see our website for more information on using 
earlier versions.

Add your account
1  open Mail and select Preferences from the main 

menu, then click on Accounts
2  click on the + button to add a new account, then 

put in your Sussex email address, username and 
password

3  click on OK

Apple Mail will obtain your details from the Sussex 
mail server and also set up calendar and contacts 
information in iCal and Address Book.

•	click on Create to set up the account and finish

Mail will then download your mail information which 
could take a long time depending on the number of 
messages in your account.

42
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�� Prevent Mail from downloading all of your messages
�� Delete old Sussex accounts from Mail
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Email with Apple Mail

You can read and send your Sussex email in Apple 
Mail and manage all of your folders. 

The folders used for sending 
or receiving email (Inbox, Sent, 
Drafts and Trash) are shown in the 
top section of the folder list. Any 
additional folders which you have set 
up are also available but shown in 
the lower part of the list.

Look up addresses
•	click on Address to find email addresses for Sussex 

colleagues
•	click on All Directories and enter a name in the 

search field
•	when located, click on a name to highlight it and 

then click To, Cc or Bcc and add to your message
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Managing your calendar with iCal

Read your Sussex calendar
•	tick the boxes next to the 

calendars listed under 
your Sussex account to 
display them

•	calendars are displayed 
in the main window in the 
selected colours

Set up a meeting or appointment
1  click on the calendar to select it, then double-click 

on the intended time to fill in the details
2  double-click an appointment and click Invite 

attendees to turn it into a meeting
3  set up an all-day event by double-clicking in the all-

day section in day or week view
4  to set up an all-day event in the Month view, 

double-click on the day and then tick all-day event

Changes you make in iCal will be synchronised with 
the University calendar system as long as you use the 
calendars listed under your Sussex account.

You can still use personal calendars in On my Mac 
which will not be synchronised.



Mobile phones and devices
Setting up an iPhone, iPad or iPod

Add your mail account
1  in Settings, choose Mail, Contacts, Calendars
2  tap Add new account and choose Microsoft 

Exchange
3  enter your email address and for the domain, type 

in ad_us
4  type in your username and password and tap Next
5  the Server name should be completed with 

exchange.sussex.ac.uk after a few seconds so tap 
Next to finish

6  if you wish, you can also turn on Contacts and 
Calendars at the same time for access to your 
Outlook calendar and address book and tap Save

If you have existing contacts or calendar entries, 
you will be asked if you want to keep them. If so, 
there is also a warning that you may have duplicate 
entries if the same contacts or calendars are in 
your Sussex accounts. 45



Setting up an Android phone

Add your mail account
1  in Settings, choose Accounts and Sync
2  tap Add account then Exchange ActiveSync
3  enter your email address and password
4  for Server address, enter exchange.sussex.ac.uk 

and ad_us for the domain
5  enter your Sussex username and password and tick 

the box for secure connection
6  turn on Contacts and Calendars at the same time 

for access to your Outlook calendar and the Sussex 
address book and tap Finish setup

If you don’t already have a password set up on your 
phone, you will be asked to choose one. 

Other phones
Please see our website for information on setting up 
other types of phone.
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Other mail programs
Connection details

Most email programs are compatible with the staff 
mail system. There’s more information on our website 
but the settings are given here for reference.
Connect as Exchange
Some email programs enable you to connect to an 
Exchange server directly with these details:

Server		  exchange.sussex.ac.uk
Domain		 ad_us

Connect with IMAP and SMTP
Alternatively, you can connect using IMAP to receive 
messages and SMTP to send:

IMAP server	 imap.exchange.sussex.ac.uk
Port		  993
Security		 SSL encryption
Authentication	 username/password

SMTP server	 smtp.sussex.ac.uk
587Port		

Security		 STARTTLS
		  (same authentication as logon) 

Please note POP access to email is not supported; if 
you need assisted access to email, please contact us 
(see back page for details).
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Further information

Phone
Extension 8090 (01273 678090)

Email
support@sussex.ac.uk

Web
sussex.ac.uk/its/exchange

IT Service Desk
Shawcross open Monday-Friday 
9am to 7pm in term time and 
9am to 5.30pm in vacations


